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Chapter 1  

Introduction 

The Marketing Operations Cookbook contains instructions for marketers and content 
authors who work with Sitecore. This guide contains step by step instructions on the 
key tasks involved in setting up and configuring Sitecore Analytics on your website. 
The subjects covered include creating profile cards and assigning them to content 
items, setting up goals, campaigns, and events, as well defining personalization rules 
and assigning them to content items. 

All of the examples in this cookbook use the Office Core website. This website is 
designed to highlight the functionality available in the Digital Marketing System.  

This cookbook contains the following chapters: 

 Chapter 1 — Introduction 
This introduction contains a description of the content, aims, and the intended 
audience of this cookbook.  

 Chapter 2 — Content Profiles 
This chapter provides step by step instructions on how to create profiles, goals, 
campaigns, multivariate tests, and personalization. It also includes instructions on 
configuring these items in the Page Editor. 

 Chapter 3 — Goals, Campaigns, and Events 
This chapter provides step by step instructions on how to assign profile values to 
content items, how to associate goals and campaigns with content items, and how to 
assign events, failures, and settings. 

 Chapter 4 — Patterns and Pattern Cards 
This chapter describes pattern cards and how to create them. 

 Chapter 5 — Testing 
This chapter provides step by step instructions on how to create multivariate tests 
using the Page Editor and the Content Editor and how to evaluate your test results. 

 Chapter 6 — Personalization 
This chapter provides step by step instructions on how to implement real time 
personalization using the Page Editor and the Content Editor. 

 Chapter 7 — Viewing Reports, Dashboards and Analyses 
This chapter describes the standard reports that are available in the Engagement 
Analytics report viewer. It also contains an overview of the Executive Insight 
Dashboard and Engagement Intelligence. 
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1.1 The Sitecore Customer Engagement Platform 

Sitecore Engagement Analytics brings together web content management, analytics, and marketing 
automation in one powerful suite of tools. Normally, you would have to spend a lot of time and money 
integrating any number of different 3

rd
 party products and tools to achieve this but Sitecore 

Engagement Analytics gives it all to you in one streamlined task oriented set of tools. Sitecore 
Engagement Analytics allows you to create, manage, and measure the effectiveness of online and 
offline campaigns. You can create profiles and measure how well visitors match these profiles and 
then display personalized content to these visitors on the fly. 

Sitecore Engagement Analytics helps you understand who your customers are and what they want to 
accomplish when they visit your web site. Sitecore Engagement Analytics generates a visitor profile 
for every visitor based on the pages they visit and their behavior during the visit. With Sitecore 
Engagement Analytics, content profiling becomes a natural part of content creation and can be 
implemented by every content author. You can easily adjust your content profiles as you get to 
understand more about your visitors and their behavior.  

Sitecore Engagement Analytics allows you to build detailed profiles of the visitors to your web site — 
even first time visitors. You can see how they came to your website, what they searched for that 
brought them to your site, as well as what they searched for on your site. You can see which pages 
and content they visited, as well as the paths they used to reach that content. You can also see which 
goals they achieved on your website and any information that they entered in the forms that your 
website contains. You can use these rich profiles to push personalized content to visitors that match 
the different profiles that you have defined for your website. 

The Executive insight Dashboard gives you an overview of the effectiveness of campaigns and 
marketing channels and the Engagement Intelligence Analyzer gives you a more detailed view of 
DMS data based on the OLAP cube. In Engagement Intelligence, you can also create your own 
analyses and get a much more detailed insight into the activities of your website visitors. Analyses 
enable you to get both an overview and to drill down into your campaign and marketing channels to 
help you to make informed business optimization decisions about your website and the campaigns 
that you run. 

Sitecore Engagement Analytics lets you configure multivariate and A/B tests out of the box without the 
assistance of any developers. These tests allow you to fine tune your campaigns and evaluate their 
success. Sitecore Engagement Analytics gives you an unprecedented understanding of your online 
campaigns, and lets you see how each campaign meets the goals of your website and how many 
conversions it achieves. Sitecore Engagement Analytics helps you track newsletter campaigns, 
Google Adwords, online ads, and any other online initiative, so that you can find out more about each 
respondent. You can see what they did once they reached your site and what content they viewed. 

When the same visitor comes to your website several times, each individual session is tied together 
by a global cookie to give you an integrated picture of the visitor’s profile, history, preferences, as well 
as what brought them to your website in the first place. This integrated picture gives you far greater 
insight into the behavior of your visitors and into the success or failure of you campaigns than CPC 
(Cost per Click) or CPM (Cost per Impression) because you can associate multiple visits, goals, 
actions, and types of visitor with each campaign. This lets you focus your activity on the campaigns 
that give the greatest return and improve or cancel the campaigns that are underperforming.  

Sitecore Engagement Analytics gives your sales team instant information about any prospects that 
visit your website. New prospects are identified by the profile and score that their activity on your 
website generates — what they downloaded, what they searched for, and what they viewed. Existing 
prospects can also be identified by the GeoIP information that the Sitecore Engagement Analytics 
reports contain. This GeoIP information includes the country, state, city, and the registered company 
name of every visitor. This information is correlated with the visitor’s activity on your website and can 
be easily integrated with leading CRM products. All of this combines to give your sales team qualified 
leads and unique insight into the needs and interests of new prospects and ultimately helps you to 
achieve online success. 
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Security Roles and Sitecore Engagement Analytics 

You must be a member of certain Sitecore security roles to access the functionality in Sitecore 
Engagement Analytics. 

The important Sitecore Engagement Analytics security roles are: 
 

Security Role Grants  

Client Authoring Access to the Marketing Center. 

Analytics Reporting Access to the Marketing Center, Engagement Plan Monitor 
and to the Executive Dashboard. 
Requires membership of the Client Authoring role. 

Analytics Maintaining Access to the Marketing Center, Engagement Plan Designer 
and Supervisor.  
Requires membership of the Client Authoring role. 

Analytics Testing Access to the Test Lab in the Marketing Center as well as 
access to the test functionality in the Page Editor and in the 
Content Editor. 
Requires membership of the Client Authoring role. 
Members of this role can create and edit test variations. 
Users who are not members of this role can switch test 
variations. 
Members of the Minimal Page Editor role cannot switch test 
variations. 

Analytics Personalization Access to the personalization functionality in the Page Editor 
and in the Content Editor. 
Requires membership of the Client Authoring role. 
Members of this role can create and edit personalization 
rules. 
Users who are not members of this role can switch 
personalization variations. 
Members of the Minimal Page Editor role cannot switch 
personalization variations. 

Analytics Content Profiling Access to the content profiling functionality in the Page Editor 
and in the Content Editor. 
Requires membership of the Client Authoring role. 

All of the analytics roles are members of the Client Users security role. 
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Chapter 2  

Content Profiles 

In Sitecore, you must assign content profile values to all of the content on your 
website. These values are then used to create a profile of each individual visitor as 
they move through your website. You can also create some goals that you want your 
visitors to achieve when they visit the site.  

This chapter describes how content profiling works and contains step by step 
instructions for creating profile cards and for assigning profile cards to content items. 

This chapter contains the following sections: 

 Content Profiling 

 Profiles, Profile Keys, and Profile Cards 

 Assigning a Profile Card to a Content Item in the Page Editor 

 Assigning a Profile Card to a Content Item in the Content Editor 
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2.1 Content Profiling 

By assigning content profile values to all of the items that make up your website you are able to gain a 
better understanding of the behavior, actions, and interests of your website visitors. As a visitor moves 
through your website they are assigned the content profile values that you have defined for each item 
they visit. These values accumulate as the visitor navigates through the site and help you build up a 
profile of the visitor. 

Marketers create content profiles, profile keys, and profile cards in the Marketing Center and content 
authors use the Page Editor to assign profile values to the contents of each web page. You can 
assign profile values to every Sitecore item that you use on your website. 

2.1.1 Profile Values, Web Pages, and Content Items 

It is important to understand the difference between a web page and a Sitecore content item and how 
this affects the profile score that visitors accumulate as they navigate through the website.  

In Sitecore, a web page is not a single entity but consists of numerous Sitecore items. When a visitor 
views a page, the visitor is assigned the profile values of the item identified in the URL for that page 
and is not assigned the profile values of all the items that make up the page.  

2.1.2 Pre-requisites 

Before you assign profile values to content items you should consider creating: 

 Website personas — the personas that your website is designed for. These are also the 
personas that your content authors should have in mind when they create the content that 
you use on your website. 

 A profiling strategy — an understanding of the content on your website and the personas it is 
designed for. This understanding helps you assign the appropriate profile values to the 
content of your website. 

Personas 

When you design your website, you should create some personas that correspond to the different 
types of people that you want to visit your website. 

Personas are fictional characters that represent different user types within your target demographic, 
attitude, and/or behavior set that might use your site in a similar way. A persona describes the life, 
habits, background, interests, and profession of a fictional character.  

Having a good understanding of the market segments or demographics that your website seeks to 
attract makes it easier for you to create these personas and to design your website.  

When your designers and content authors create your website and write the content for it they should 
ensure that it contains content that appeals to these personas.  

Profile Cards 

Creating profile cards and profile keys enables you to categorize the content on your website and 
ultimately helps you to classify the visitors to your website.  

The profile cards and keys that you create should reflect the interests of the personas that you 
designed your website for. When a visitor views a page on your website, they receive the profile 
values that you have assigned to that content item. As the visitor navigates through the website, they 
accumulate the profile values of all the pages they visit and this gives you an insight into the different 
kinds of content that they are interested in. The profile values that visitors accumulate are displayed 
as a bar chart in the session trail.  
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All of the information that you collect about the visitors to your website, the pages they view, the goals 
they complete, and the path they use to navigate through the site can help content authors to identify 
areas of the website that could benefit from improvement. You can also use this information to 
segment the visitors to your website and to create rules for personalization. 

Profile Values 

The profile values that a visitor accumulates during a visit give you an insight into the visitor’s level of 
interest in your website. For example, assigning a high lead profile value to an item, such as a 
brochure download page, means that when a visitor views this page they are demonstrating a high 
level of interest in reading one of your brochures and are potentially interested in buying one of your 
products and can be targeted as a potential sales lead. 

This information can be particularly useful to your sales team. For example, if a visitor achieves a high 
lead profile value, this can indicate that they are a potential customer and therefore represent a sales 
opportunity. 

Examples of profile values: 
 

Profile Values Example 

Lead Pages related to price carry a high lead profile value on your 
website. Knowing which visitors achieve a high lead profile value 
can help your sales team to target potential new customers. 

Investor A visitor has viewed the annual report page on your site. 
Assigning a high investor profile value to this page can help you 
identify visitors that are interested in investing in your company. 

Big spender Assigning a high profile value to a page that records the total 
purchase amount used by visitors to your site can indicate which 
visitors are the biggest spenders.  

To demonstrate this concept, the Office Core website is configured to record Lead profile values. The 
deeper a visitor navigates into the website, the higher is the lead profile value that they accumulate. 
Some pages and actions carry higher lead profile values than others. For example, downloading a 
brochure carries a high lead profile value.  

The Engagement Analytics application contains the lead reports and you can drill down to the session 
trail to see the lead profile values accumulated by each visitor. 
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2.2 Profiles, Profile Keys, and Profile Cards 

A web site can consist of any number of pages. When you assign profile values to each page it can 
be very difficult to ensure that you assign them consistently across the entire website. 

To facilitate the process of assigning profile values to content items, Sitecore lets you create profile 
cards that contain a specific set of profile values. You can use these cards to assign these predefined 
profile values to content items.  

Sitecore Engagement Analytics comes with some predefined profiles that illustrate a number of these 
key concepts. Each of these profiles has been assigned some profile keys. 

 

The predefined profiles and profile keys are: 
 

Profiles  Profile Keys 

Focus Background 

Practical 

Process 

Scope 

Function Building Trust 

Call to Action 

Create Desire 

Define Concept 

Persona Cecile 

Chris 

Ian 

Sandra 

Score Lead 

Focus 

This profile contains profile keys that you can use to indicate the emphasis that each content item 
has. Does the content item contain mainly background information or does it focus on practical 
information? 
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Function 

This profile contains profile keys that you can use to indicate the purpose of each content item. Is the 
content item designed to build trust in your products or to increase the visitor’s desire to own one of 
the products? 

Persona 

This profile could be used to contain the profile keys that reflect the personas that you use when you 
design your website. 

Score 

This profile contains the lead value that you can assign to each content item. Does viewing this 
content item indicate that the visitor is a potential customer or not? 

Under each profile you can also create any number of profile cards that contain predefined profile 
values that you can assign to the content items on your website.  

2.2.1 Creating a Profile Card 

Before you start assigning profile values to the content items that make up your website, you will 
probably need to create some new profile cards. 

Important 
A profile card is not the same as a persona. A persona describes the life, habits, background, 
interests, and profession of a fictional character and therefore contains aspects from all of the profiles. 
A profile card only refers to the aspects of a single profile. 

Before you start to create profile cards, you should consider the profiles that are suitable for your 
website and whether it is appropriate to assign one or more profile cards for each profile to the 
content items that make up your website. If you decide that it is appropriate to assign multiple profile 
cards, you should also specify whether you want to be able to specify the relative importance that the 
content item has for each profile card. 

To specify how many profile cards you can assign to content items: 

1. Click the Sitecore menu and then click Marketing Center. 

2. In the Marketing Center, expand the content tree and click Profiles. 

3. Select the profile that you are interested in and then click the Profile Cards folder. 
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4. On the Content tab, in the Authoring Selection field, click the drop-down arrow and select 
one of the options. 

 

The options are: 
 

Option Description 

Single You can only assign one profile card to each content item. 

Multiple You can assign several profile cards to each content item. 

Multiple with Percentages You can assign several profile cards to each content item 
and assign a percentage weighting to each profile card. 

To create a profile card: 

1. Click the Sitecore menu and then click Marketing Center. 

2. In the Marketing Center, expand the content tree and click Profiles. Select the profile that 
you are interested in and then click the Profile Cards folder. 

3. In the Home tab, in the Insert group, click Profile Card to create a new profile card. 

 

4. Give the profile card a name, such as, Decision Maker.  
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Assigning Profile Values to a Profile Card 

After you create the profile card, you can assign some appropriate profile values to this card. 

To assign profile values to a profile card: 

1. In the Marketing Center, select the new profile card.  

2. In the Content tab, scroll down to the Profile Card Value field. 

3. In the Profile Card Value field, select the profile values that you want to assign to this card. 

 

This item also contains a number of other fields that you can use to enter background 
information about this profile that may be useful for content authors who are not familiar with 
your target demographics. 

You can create as many profile cards for each profile as you need. 

4.  Click Save. 

You can create any number of profiles and profile keys but it is worthwhile planning a profiling 
strategy before you start creating profiles and profile cards. 



Sitecore CMS 7.0 

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 14 of 123 

2.3 Assigning a Profile Card to a Content Item in the Page 
Editor 

After you have created the profile cards and assigned profile values to them, you can start assigning 
the profile cards to the content items that make up your website. Assigning profile cards to content 
items makes it easier for you to implement profile values consistently across your website.  

To assign a profile card to a content item: 

1. In the Page Editor, navigate to the page that you want to assign a profile card to. 

 

2. On the Advanced tab, in the Analyze group, to edit all profiles on this page, click the drop 
down arrow. 

 



Marketing Operations Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 15 of 123 

Then click Edit the profiles. 

 

3. In the Profile Cards dialog box, select the profile that you are interested in and click Edit and 
the Select Profile Card dialog box appears. 

 

The Select Profile Cards dialog box looks different depending on which option you selected 
earlier in the Authoring Selection field. 

The options are: 
 

Option Description 

Single You can only assign one profile card to each content 
item. 

Multiple You can assign several profile cards to each content 
item. 

Multiple with Percentages You can assign several profile cards to each content 
item and assign percentages to each profile card. 
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If you selected the Single option in the Authoring Selection field, the Select Profile Cards 
dialog box looks like this: 

 

4. In the Select Profile Cards dialog box, in the Profile Cards field, select the profile card that 
you want to assign to this content item and the profile values that you gave to this card are 
assigned to the current content item. 

If you selected the Multiple option in the Authoring Selection field, the Select Profile Cards 
dialog box looks like this: 
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5. In the Profile Cards field, select the profile cards that you want to assign to this content item 
and click Add. 

 

The total value of the all the profile cards that you select is assigned to the content item. 

If you selected the Multiple with Percentages option in the Authoring Selection field, the 
Select Profile Cards dialog box looks like this: 
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6. In the Profile Cards field, select the profile cards that you want to assign to this content item 
and click Add. 

 

7. In the Profile Card Details field, in the drop down box for each profile card, select the 
percentage of importance/relevance that you want to assign to each profile card. 

 

The sum of the percentages that you select must be 100%.  

If the sum of the percentages that you select is not 100%, Sitecore displays a message informing you 
of this and that allows you to recalculate the percentages automatically or to change them manually. 

If you decide that Sitecore should recalculate the percentages automatically, it increases or 
decreases the percentages proportionally. 
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After you have assigned some profile cards to the content item, the Profile Cards dialog box reflects 
the changes you have made. 

 

After you have assigned some profile cards to a page, on the Advanced tab, in the Analyze group, 
you can see the profile cards that you have assigned.  

 

The Analyze group now displays an icon for each of the profile cards that you assigned to the page. 
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When you move the mouse over one of the profile card icons the Page Editor displays a tooltip with 
the name profile card.  

 

2.3.1 Assigning Custom Profile Values to a Content Item in the Page 
Editor 

When you are assigning profile values to the content items on your website, there could be some 
content items for which the profile cards that you have created are not appropriate. In these cases, 
you can assign custom profile values to the content item. 

Important 
You can only assign custom profile values to content items if you select Single in the Authoring 
Selection field when you decide which kind of profile cards you want to use. 

To assign custom profile values to a content item: 

1. In the Page Editor, navigate to the page or content item that you want to assign profile values 
to. 
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2. In the Content pane, select the profile that you want to create custom profile values for and 
assign to the content item. 

 

3. In the Select Profile Card dialog box, click Customize. 

4. In the Customize section, click the drop down arrow for each profile value and select the 
values that you want to assign to the content item. 

 

5. Click OK to save your changes. The profile values you selected are assigned to this content 
item. 
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2.4 Assigning a Profile Card to a Content Item in the Content 
Editor 

When content authors use the Content Editor to create and edit the content items that make up your 
website, they can also assign profile values and profile cards to these items. 

To assign profile cards and profile values to an item in the Content Editor: 

1. In the Content Editor, content tree navigate to the page that contains the item that you want 
to assign profile values. 

 

2. On the Content tab, click the profile card icon in the top right-hand corner and the Profile 
Cards dialog box appears. 

 

3. The functionality available here is the same as in the Page Editor. 

For more information about assigning profile cards, see the section Assigning a Profile Card to a 
Content Item in the Page Editor. 
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2.4.1 Assigning Custom Profile Values to Multiple Content Items 

In Sitecore search, item buckets, you can use search operations to apply a profile value or set of 
values to multiple content items. If your website contains thousands or millions of items, these bulk 
operations enable you to apply changes more quickly. 

To assign custom profile values to multiple content items: 

1. Select a content item or item bucket. For example, Services. 

2. In the search field enter * to return all items in the item bucket. 

3. Click the drop down to the left of the search field and select Search Operations. 

4. In Search Operations, click Apply Profile Score to All Items to open the Profile Cards 
window. 

 

5. In the Profile Cards window, follow the same procedure as you did to assign values to a 
single content item. For more information on how to do this see, Assigning Custom Profile 
Values to a Content Item in the Page Editor. 

When you have finished assigning profile values to your profile keys, click OK and these 
values are applied to all the content items that appeared in your search results. 
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Chapter 3  

Goals, Campaigns, and Events 

Sitecore lets you manage your marketing campaigns and use them to engage with 
your customers. You can also create goals and events that can be associated with 
these campaigns and help you measure the success of your campaign activities — 
both online and offline. 

Furthermore, you can specify that visitors who participate in a campaign and come to 
a particular landing page are automatically assigned to a state in an engagement 
plan. 

This chapter contains the following sections: 

 Goal 

 Campaign 

 Events 

 Analytics Page Settings 
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3.1 Goals 

You create goals to measure the success of your website and your marketing campaigns — both 
online and offline.  

You can create a goal for any activity that visitors can perform on your website. 

Examples of goals:  

 Download a brochure 

 Register for an e-mail newsletter 

 Visit a particular page 

 Sign up for an online demo 

Once you have created some goals, you can measure the conversion rate for each goal — the 
percentage of visitors that achieve a particular goal. The website performance reports show goals and 
conversion rates. 

You can create an engagement plan that uses goals to evaluate what action should be taken. For 
more information about engagement plans, see the Engagement Automation Cookbook. 

You can create personalization rules that are based on the goals that a visitor achieves. For more 
information about personalization rules, see the section Personalization. 

3.1.1 Creating a Goal 

To create a new goal: 

1. Open the Marketing Center and click Goals.  

2. On the Home tab, Insert group, click Goal to create a new goal definition item. 

 

3. Give the goal a name, such as, Arch Digest Sign-up. 
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4. In the new goal definition item, enter the appropriate values. 

 
Field Value 

Name The name for your goal.  

Points The number of engagement value points that are assigned to a 
visitor when they achieve this goal. 
 
Every time a visitor lands on a page that has a goal or page event 
associated with it, they accumulate the engagement value points 
that are assigned to that event or goal. When the visitor leaves the 
website this score becomes the engagement value for that visit.  
The number of engagement value points allocated to each goal is 
not important but the ratio between engagement value points 
assigned to the different goals is. For example, the marketer must 
understand why the Request for Demo goal is four times more 
valuable than the Newsletter Registration goal. 

Category A suitable description, such as, User has registered for Arch 
Digest. 

Description This defines the event as a system event. 
For administrators and advanced users only. 

Rule Select the rule that should be evaluated when the page event 
associated with this goal is triggered. 

IsAuthorFeedback Select this checkbox if the page events associated with this goal 
are of interest to content authors. 

IsFailure Select this checkbox to define the event as a failure.  
For administrators and advanced users only. 

IsGoal Select this checkbox to ensure that the goal appears in the 
Content Editor, Goals dialog box. You can then associate the 
goal with a content item. 

IsSystem Select this checkbox if the page event describes a system event. 

5. Click Save to save the new goal. 
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Engagement Value Points 

When you create a goal, you can assign some engagement value points to it. The number of 
engagement value points that you assign should reflect the value that you ascribe to each goal. You 
can also assign profile cards and profile values to each goal. Every time a visitor achieves a goal, 
Sitecore assigns these profile values and engagement value points to their profile. This allows you to 
measure the engagement value of each visit as well as the accumulated engagement value of each 
visitor. 

You can create personalization rules that are based on the number of engagement value points that a 
visitor accumulates. You can also create engagement plans that evaluate the number of engagement 
value points that a visitor has achieved to determine what action should be taken. 

For more information about engagement value points and engagement value, see the Executive 
Dashboard Cookbook. 

For more information about personalization rules, see the section Personalization. 

For more information about engagement plans, see the Engagement Automation Cookbook. 

3.1.2 Deploying and Publishing a Goal 

When you create a goal, it is subject to a workflow. You must deploy the new goal before it becomes 
available in the Marketing Center and you can associate it with a content item or a campaign. 

To deploy a goal: 

1. In the Marketing Center, select the goal that you want to deploy. 

2. On the Review tab, in the Workflow group, click Deploy. 

 

The new goal is now available in the Marketing Center and you can associate it with content items 
and use it in your campaigns. 

However, like every other item, a goal must also be published on your website before it is available to 
your website visitors. 



Sitecore CMS 7.0 

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 28 of 123 

3.1.3 Associating a Goal with a Content Item 

After you have created a goal and deployed it, you can associate it with a content item. This means 
that the goal is achieved every time a visitor views this item. 

In this example, we associate the goal with a landing page that contains a form that lets visitors who 
read a magazine called Architectural Digest sign up for a site audit at a 50% reduction. 

To associate a goal with a content item: 

1. In the Content Editor, navigate to the content item you are interested in. In this example we 
want to associate the goal with a landing page. 

2. Click the Analyze tab and in the Attributes group, click Goals. 

 

3. In the Goals dialog box, select the goal that you want to associate with this item. 

In this example, we associate the Arch Digest Sign-up goal with a landing page that contains 
the form that the visitor must use to avail of the offer. 

3.1.4 Associating a Goal with Media Item 

You can associate goals with any type of Sitecore content items. If you have media items such as 
PDF documents or videos on your website, it may be useful to track how many visitors have 
downloaded or viewed these media items. View reports to find out how many visitors have 
downloaded or viewed media items. 

Creating a goal to associate with the media item: 

1. Open the Marketing Center. 

2. Select Goals. 

3. In the Insert group, click Goal to create a new goal item. 

4. In this example, name the new goal Brochure Download. 

5. In the Points field, enter a value, for example 5. 

6. Publish and approve in the workflow if you have this enabled. 

7. In the ribbon, click Save. 

To associate a goal with a media item: 

1. In the Sitecore Desktop, open the Media Library. 

2. Navigate or search for the content item you want to track. 
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3. In this example, select the Office Core Design brochure 2011. 

4. In the ribbon, Analyze tab, Attributes group click Goals. 

5. In the Goals dialog box, clear the Brochures Request check box and instead select 
Brochure Download. 

 

6. In the Media Library ribbon, click Save. 

Now every time a visitor opens the Office Core Design brochure 2011 PDF this triggers a goal 
conversion event in Engagement Analytics that is recorded in the Visits Detail (Session) report. 
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3.1.5 Associating a Campaign or Event with Multiple Content Items 

Using item buckets and Sitecore search, you can carry out bulk actions on multiple content items, 
such as, associating a campaign, page event, failure action or other setting on multiple content items. 
To do this, in item buckets you can use one of the operations available under Search Operations.  

To apply a campaign to multiple content items: 

1. Search for the items you want to perform an action on. For example, you could have an item 
bucket containing multiple products or news articles and you want to link all these products or 
news articles to a specific campaign. 

2. Select an item bucket and enter * in the search field to return all the items contained in this 
item bucket. 

 

3. Click the drop down next to the search field to see more search options that you can apply to 
your search results. 
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4. In the search options, click Search Operations to display a list of the actions to apply to your 
search results. 

 

5. Click Apply Campaigns or Events to all items to open the attributes dialog box. 

6. In the Attributes dialog box, select a campaign or event that you want to associate the items 
in your search results with. In this example, select the campaign Office Core Promotional 
Campaign. 

 

7. Click OK. The campaign is now associated with all the items in your search results. 
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3.2 Campaigns 

A campaign is a promotion or advertising initiative designed to encourage people to come to a 
website and perform some desired actions. 

Sitecore Analytics supports two types of campaigns: 

 Online Campaigns 

 Offline Campaigns  

In the Executive Insight Dashboard, you can view charts that show which of your campaigns are the 
most successful. You can then improve or drop unsuccessful campaigns and improve your ROI. 

For more information on the Executive Insight Dashboard, see Viewing Campaign Categories in the 
Executive Dashboard. 

You can create an engagement plan that uses campaigns to evaluate what action should be taken. 
For more information about engagement plans, see the Engagement Automation Cookbook. 

You can create personalization rules that are based on the campaigns that a visitor takes part in. For 
more information about personalization rules, see the section Personalization. 

3.2.1 Creating a Campaign 

When you create a campaign, you first need to create a campaign category. Campaign categories 
enable you to categorize your marketing campaigns. In the Executive Insight Dashboard, you can 
view each campaign and campaign category using the All campaigns drop-down list. 

To create a campaign and campaign category: 

1. In the Marketing Center, click Campaigns, and then on the Home tab, in the Insert group, 
click Campaign Category. 

2. Give your new category a name, for example, Online Campaigns and click OK. 

3. Select the Online Campaigns category and then on the Home tab, in the Insert group, click 
Campaign to create a new campaign item 

4. Give your new campaign a name, for example, Architectural Digest and click OK. 
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5. In the new campaign item, enter the appropriate values. If you wish, you can complete these 
fields later. 

 
Field Value 

Title The title of the campaign. 

Campaign Link The campaign query string.  
For example: 
sc_camp=7147FC33D65741B78CF354926779C1AE 

Append the query to the link to your website provided on the 
sponsored site. If the link already includes a query string, 
prefix the provided text with an ampersand (&). If the link 
does not include an existing query string, prefix the text with 
a question mark (?).  
This ensures that site visits generated by this campaign are 
recorded in the analytics system. 

Type A campaign can either be ‘online’ or ‘offline’. 

Enroll in Engagement 
Plan 

Select the engagement plan state that you would like to 
assign visitors to when they participate in this campaign. 
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Field Value 

Change Traffic Type 
(for every visit that 
triggers this 
campaign) 

For each visitor that triggers this campaign, you can decide 
whether the traffic type allocated to the visit should be 
changed or allocated automatically. 
You can select one of three options: 
 

Change Traffic Type? Description 

No Do not change the traffic type 
that is automatically 
assigned. 

Yes – if this campaign is 
triggered on the landing 
page. 

If this campaign is triggered 
on the landing page then 
change to the traffic type 
specified in the Select Traffic 
Type field. e.g. Email. 

Yes - Always Always change the traffic 
type in this way, even if this 
campaign is not triggered on 
the landing page. 

 
How to use the Change Traffic Type drop down: 
 
Example 1. 
A visitor might come from a paid Google AdWords campaign 
to reach your page. If you select ‘No’ in this field, then the 
visit will automatically be put into the Search Engine – 
Organic or Search Engine – Organic Branded category.  
This is incorrect as you want this visit to be classified as 
‘Paid’. 
To ensure that this visit is always classified as the ‘Paid’ 
traffic type select ‘Yes – if this campaign is triggered on the 
landing page’ and then select traffic type as ‘Paid’. 

 
Example 2. 
A visitor might come from an email campaign that you sent, 
to reach your page. If you select ‘No’ in this field, then the 
visit will automatically be put into the Referred - Other 
category. This is incorrect as you always want this visit to be 
classified as ‘Email’.  
To ensure that this visit is classified as the Email’ traffic type 
select ‘Yes – if this campaign is triggered on the landing 
page’ and then select traffic type as ‘Paid’. 
 

Select Traffic Type To specify which traffic type to change a visit to, select one of 
the options in this drop down. 

StartDate The start date for the campaign. 

EndDate The end date for the campaign. 
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Field Value 

Cost The total cost of your campaign. 
You can enter values into the Cost, Cost Base, Cost per 
Click and Cost per Day fields to keep a record of the costs 
incurred for an individual campaign.  
To extend this functionality further you could create a custom 
report to display a breakdown of costs incurred for each 
campaign. These fields appear in the Analytics database, so 
could be used in SQL queries that would help you to 
calculate a more accurate ROMI. 

Cost Base If the campaign has a fixed one off price. For example, a 
fixed price banner campaign. 

Cost per Click For a campaign with a fixed click fee such as a banner ad it 
is possible to calculate the cost per click of each visit. 
This is more difficult for campaigns such as Google AdWords 
as these campaigns can have a variable cost per click. 

Cost per Day You may have an ad that incurs a cost on a daily basis 
regardless of how many times a visitor clicks on your ad. 

Hidden Whether or not the campaign should be shown in reports. 
For example, you may not want to show campaigns that are 
created automatically in your campaign reports. 

6. Click Save to save the new campaign. 

For more information about engagement plans, see the Engagement Automation Cookbook. 

Deploy the Campaign 

You must deploy the new campaign item to ensure that it is available in the Marketing Center.  

Important 
You must deploy a campaign in the workflow before you can associate it with a content item.  

To deploy a campaign: 

1. In the Marketing Center, select the campaign that you want to deploy. 

2. On the Review tab, in the Workflow group, click Deploy. 

3.2.2 Associating a Campaign with a Content Item 

After creating a campaign in the Marketing Center, you must ensure that the campaign is triggered in 
Sitecore Analytics so you can track which campaigns your site visitors have come from. 

To associate a campaign with a content item: 

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to associate a campaign with.  

In this example we are using a landing page. 



Sitecore CMS 7.0 

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 36 of 123 

2. On the Analyze tab, in the Attributes group, click Attributes. 

 

3. In the Attributes dialog box, click the Campaigns tab and then select the campaign that you 
want to associate with the content item. 

Online Campaigns 

An online campaign consists of a campaign definition item and a campaign event. To associate an 
online campaign with a content item, you must copy the campaign query string to the sponsored site 
and if necessary edit the query string to point to a page on your website. 

To associate an online campaign with a content item: 

1. Open the Marketing Center.  

2. Expand the Campaigns node and then click Google AdWords Award Winning Campaign. 

 

3. In the Campaign Link field, copy the query string. 

4. Paste the query string to your sponsored site. 

This example uses a Google AdWords campaign. 
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5. Paste the campaign query string into your sponsored site. 

 

You must append the query string to your site URL. In this example the website URL is: 

www.sitecore.net/default.aspx  

The query string provided for this campaign is: 

sc_camp=E0E6A1A02F5342F1BC30DABCC3670A20 

6. After you insert the query string, you must insert a question mark to complete the path, as this 
is not included in the Campaign Link field: 

www.sitecore.net/default.aspx?sc_camp=E0E6A1A02F5342F1BC30DABCC3670A20 

7. By default the campaign query string links to your home page. To point to a different page, 
you must edit the query string.  

For example, you could replace /default.aspx? with /Our-Services.aspx? 

 

When a visitor comes to your website from this campaign, a campaign event is triggered in Sitecore 
Analytics, and this is recorded in the Latest Visits report.  

Publishing the Goals and Campaigns 

You must publish the new goals and campaign items to make them available on your website 

 In the Publishing wizard, select the Smart Publish option. 

3.2.3 Viewing Campaigns in Engagement Analytics 

After you have published the relevant items on your website, you can launch your campaign to attract 
visitors to come to your website and achieve the goals that you have defined.  

Once visitors can access these pages and achieve these goals, you can view the statistics generated 
by their visits and evaluate the value achieved by your campaigns. 

To view the visitor activity: 

1. In the Sitecore Desktop, click Sitecore, Engagement Analytics. 



Sitecore CMS 7.0 

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 38 of 123 

2. In the Engagement Analytics dialog box, expand the Recent Activities node and then click 
Latest Visits. 

 

As you can see, the Value column shows that some of the visitors have visited the page 
associated with the campaign, achieved the goal, and scored some points. 

You can drill down into each session to get more detailed information about each visit. 

For more information about the reports that are available in the Engagement Analytics 
dialog box, see the Marketing Operations Cookbook. 

3.2.4 Viewing Campaign Categories in the Executive Dashboard 

You can use the Executive Insight Dashboard to view information about each campaign category. 

To view campaign categories in the Executive Insight Dashboard: 

1. In the Sitecore Desktop, open the Executive Dashboard. 

2. Use the two drop-down lists at the top left of the dashboard to select a campaign category. 

 



Marketing Operations Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 39 of 123 

3. Select Campaign in the first top drop down box. 

4. In the second drop-down box, select a campaign category. 

3.2.5 Viewing the Executive Insight Dashboard from the Marketing 
Center 

In the Sitecore Desktop, Marketing Center, you can also view campaigns or campaign categories in 
an embedded Executive Insight Dashboard. 

A Google AdWords campaign Dashboard tab viewed from the Marketing Center: 

 

To view an embedded campaigns dashboard: 

1. In the Sitecore Desktop, open the Marketing Center. 

2. Expand a campaign category and click on a campaign. 

In the Content area, to the right of the content tree, a Dashboard tab starts loading. 

3. If there is no data available for the campaign then you will see an error. If you are expecting to 
see data then click Reload data to get the latest data available or wait until the cache has 
been cleared. 

The Dashboard tab can only display the Executive Insight Dashboard if your campaign 
landing page has had one or more visits. If you still cannot see any campaign data check the 
configuration of your campaign landing page and view the Engagement Analytics, Visit Detail 
(Session) report to find out if your campaign has been triggered. 

For more information about viewing campaigns in the Executive Insight Dashboard, see the Executive 
Dashboard Cookbook. 
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3.3 Events 

You can use events to track user activity on a website. You can track events, such as, download, 
search, registration, or logout. Tracking events help to build up a more comprehensive picture of a 
visitor’s behavior as they navigate through the website. 

Goal and campaign events are triggered when visitors achieve certain objectives on the website or 
when they come to a site from a promotion or campaign that you have created. These events are 
tracked in Sitecore Engagement Analytics and appear in the campaign and conversion tracking 
reports. 

Sitecore administrators can edit existing events and create additional events if you need them. The 
marketer must remember to specify how many engagement value points should be assigned to each 
event. 

You can create engagement plans that use events to evaluate what action should be taken. For more 
information about engagement plans, see the Engagement Automation Cookbook. 

3.3.1 Associating an Event with a Content Item 

You can associate events with single content items or use search operations to assign events in bulk 
to multiple content items. 

To assign an event to a content item:  

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to associate an event with.  

2. On the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog 
box. 

 

3. In the Attributes dialog box, click the Events tab, and select the event that you want to 
associate with the content item. 

4. Click OK to save your changes and close the Attributes dialog box.  



Marketing Operations Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 41 of 123 

3.3.2 Assigning Failure Actions to Items 

Failure actions are another type of event. Normally page failures are recorded programmatically. You 
can, however, use failure actions to record any page failures that occur on the website.  

For example, if you have an error page that you display to site visitors when an error occurs, you can 
associate a failure action such as Page Error with this page. Then when a visitor sees this page, a 
page error is recorded in Sitecore Analytics and you can track all the page errors that occur on your 
site in this way. 

You can associate failure actions with single content items or use search operations to assign failure 
actions in bulk to multiple content items. 

To associate a failure action with a content item: 

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to associate an event with. 

2. On the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog 
box. 

 

3. In the Attributes dialog box, click the Failure Actions tab, and select the event that you want 
to associate with the content item. 

4. Click OK to save your changes and close the Attributes dialog box. 

3.3.3 Engagement Value Points and Events 

Sitecore administrators can create any extra events that you may need. They can also specify the 
number of engagement value points that you want to assign to each event.  
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Every time a visitor lands on a page that has an event associated with it, they accumulate the 
engagement value points that are assigned to that event. When the visitor leaves the website this 
score becomes the engagement value for that visit.  

The number of engagement value points that you assign to each event should reflect the relative 
importance that you attach to each event and the importance that each event has in your marketing 
endeavors. 

You can create personalization rules that are based on the number of engagement value points that a 
visitor accumulates. 

For more information about engagement value points and engagement value, see the Executive 
Dashboard Cookbook. 

For more information about personalization rules, see the section Personalization. 
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3.4 Analytics Page Settings  

You can also disable analytics on any content item on your website. When you select the Disable 
Analytics for the Page setting, the page is no longer visible in the visitor session trail or any other 
reports in Sitecore. 

This is useful if you, for example, have a page that automatically redirects visitors to another page. 
You may not want such a page to appear in reports and session trails. 

To set an analytics setting on a content item: 

1. In the Content Editor, expand the content tree and navigate to the content item that you want 
to set an analytics setting for. 

2. Click the Analyze tab and in the Attributes group, click Attributes to open the Attributes 
dialog box. 

 

3. In the Attributes dialog box, click the Settings tab and select the Disable Analytics for this 
Page setting to assign this setting to the content item. 

4. Click OK to save your changes and close the Attributes dialog box. 
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Chapter 4  

Patterns and Pattern Cards 

Sitecore contains a system that lets you groups visitors according to their interests 
and behavior. This system makes it easier for you to design and implement 
engagement plans and personalization rules that consistently control the way your 
organization interacts with these visitor groups. 

You create pattern cards that match some typical forms of visitor behavior. This 
chapter describes how to create pattern cards as well as some typical tasks where 
you can use them. 

This chapter contains the following sections: 

 Understanding Pattern Cards 

 Creating a Pattern Card 
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4.1 Understanding Pattern Cards 

Patterns cards allow you to classify visitors according to the behavior and interests that they exhibit 
when they visit your website. 

Your website can receive thousands of visitors every day. This can make it very difficult for you to 
classify these visitors in a meaningful way. The visitor classification that you use can affect the way 
your organization interacts with the visitors to your website by influencing, for example, the actions 
that you can perform in your engagement plans, and the personalization rules that you implement on 
your website. 

Sitecore allows you to create pattern cards that reflect the behavior and interests of specific types of 
visitor. You can then use these cards to define the actions that your organization should take when a 
visitor exhibits the behavior and interests personified by a pattern card. 

When you create a pattern card, you must assign profile values to it. These profile values should 
reflect the interests and behavior of a particular type of visitor. For example, the profile values that you 
assign to the pattern card could be based on your understanding of the interests and behavior of a 
particular market segment that you have identified and are focusing some of your marketing activities 
on. 

When a visitor to your website, navigates through the site and visits different pages and consumes 
different resources, they accumulate the profile values of all the pages and resources that they 
request. Sitecore calculates the average score that the visitor has accumulated for each profile and 
maps the visitor to the pattern card that is the closest match.  

A visitor can only be mapped to one pattern card at a time. However, as a visitor navigates through 
your website, the pattern card that they are mapped to can change as they consume different 
resources on the site. 

If you have created any engagement plans or personalization rules that use this pattern card, the 
visitor is then subject to these engagement plans and personalization rules. You can create several 
different pattern cards for each profile and use these to define different personalization rules. 

4.1.1 Configuring Pattern Matching 

Sitecore uses a measurement called N-Dimensional Euclidean Distance to calculate which pattern 
card a visitor’s accumulated profile value most closely resembles and should therefore be mapped to.  

When you configure the pattern matching feature, you must specify how many pages a visitor should 
request before Sitecore starts to map their accumulated profile score to a pattern card. 

To specify the minimum number of pages that a visitor must request: 

1. Navigate to Sitecore build number\Website\App_Config\Include and open the 

Sitecore.Analytics.config file for your website. 

2. In the configuration/sitecore/settings section, add the following line: 

<setting name=”Analytics.Patterns.MinimalProfileScoreCount” 

value=”3”/> 

This means that Sitecore starts to map the visitor’s behavior to a pattern card when they have 
requested more than three pages. 

3. Change the value to what you think is a suitable number of page requests. 

The value you decide to use should be based on your understanding of your website, its size, 
and the number of pages that you assign profile values to. 
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4.2 Creating a Pattern Card 

Patterns cards allow you to classify visitors according to the behavior and interests that they exhibit 
when they visit your website. 

When you create a pattern card, it can only reflect the visitor behavior that relates to a single profile. 
You can, of course, create pattern cards for each different profile that you have defined as well as 
create several different patterns cards for each profile. 

To create a pattern card: 

1. Open the Marketing Center and expand the content tree. 

2. In the content tree, navigate to Marketing Center/Profiles. 

3. Select the profile that you want to create a pattern card for and expand it. 

 

4. Select the Pattern Cards item and then on the Folder tab, click Pattern Card. 

5. Give the new pattern card a name and click OK to create it. 

6. In the new pattern card item, enter the appropriate information. 
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7. In the Pattern field, enter the profile values that you think are appropriate for the visitor 
behavior that you want to characterize. 

 

8. Save your changes. 

You can create several different pattern cards for each profile. 

Planning your Pattern Card Strategy 

You should plan your pattern card implementation carefully to ensure that you create the cards you 
need. These cards should reflect the visitor types or market segments that you are most interested in 
engaging with and you must assign appropriate profile key values to each pattern card.  

Your pattern card implementation should be based on an analysis of your website — its aims, 
content, and ambitions — as well as an analysis of your target audience — their characteristics, 
interests, and preferences. This analysis will not only affect the design of your website but also the 
way you interact with the visitors to your website, and the personalization rules that you create. 

For more information about creating a personalization rule, see the section Creating a Personalization 
Rule Based on a Pattern Card. 
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Chapter 5  

Testing 

This chapter explains how to create and run multivariate tests using the Page Editor 
and the Content Editor. In Engagement Analytics, create MV tests to find the most 
effective content or combinations of content to use on your website. 

This chapter contains the following sections: 

 Multivariate Testing 

 Creating a Multivariate Test in the Page Editor 

 Creating a Multivariate Test in the Content Editor 
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5.1 Multivariate Testing 

Sitecore Analytics lets you dynamically test the content of your website to find out which components 
or combination of components are the most effective. 

You can create multivariate tests to see which variations of text and images work best with site 
visitors. This can be particularly useful as a part of your strategy when setting goals and optimizing 
campaigns.  

The Page Editor is the most convenient and flexible tool to use when creating multivariate tests. It 
enables you to use existing Sitecore content or create new content ‘on the fly’ without leaving your 
website. 

5.1.1 Page Editor Testing Options 

When you use the Page Editor to create a multivariate test, you have the following testing options: 

 Test existing content — prepare several test variations as content items and make them 
available in the content tree. For example, on the Office Core website, the Register-Form 
content in the Standard Items folder. 

 Clone a content item — this enables you to duplicate test variable variations. 

 Create new content — create new content ‘on the fly’ to use in your test. 

 Change a component in the test — in the Test the Component dialog box, select Enable 
variation of component design. This allows you to choose a different rendering or sublayout. 

 Hide a component in the test — in the Test the Component dialog box, select Hide the 
Component. 

 Create a combination test — this enables you to select multiple content items on the same 
page and then test them using a combination test. 
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5.2 Creating a Multivariate Test in the Page Editor 

In this example, create a multivariate test for a newsletter register form. Visitors to your website enter 
their email address on this form to register for an e-mail newsletter. Test three different combinations 
of text and graphics to find out which generates the highest engagement value on the website and to 
indicate which content is most effective. Choose the most effective content as the winner. 

When you have finish running the test, look at your results in the Stop the Test dialog box. You can 
see each test variable variation and an accumulated value next to each one. You can pick winning 
content in this way but first you should consider what effect the test has had on overall engagement 
value generated on the website. Has the winning content led to higher engagement values overall or 
just in relation to the goal assigned to the test variable? 

5.2.1 Creating an MV Test in the Page Editor 

To create a multivariate test in the Page Editor: 

1. Open the Page Editor. 

2. Select the component on your website that you want to test. For example, the Register Form. 

 

3. Move the mouse over the floating toolbar until you see the tool tip Test the component. 

 



Marketing Operations Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 51 of 123 

4. Click the Test button to open the Test the Component dialog box. 

 

5. In the Test the Component dialog box, click New Variation to create a new test variation 
variable. 
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6. Browse the Sitecore content tree to locate the test content items. Follow the same procedure 
for each of the components that you want to add to the test. 

 

Note 
You can also use Search for Content to find the item you want to add to the test. 

7. Browsing for existing content is just one of the options you have here. 

The other options are: 

o Browse for content in the content tree. 

o Change the component in the test, if you first select the Enable variation of component 
design check box. 

o Hide the component. 

8. In this example, we select three variations of the Register Form control from the Standard 
Items folder. 
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9. Enter a name for each test variable that you add. For example, Blue-Arrow. 

 

10. In the Test the Component dialog box, when you have added all your test variable 
variations, click OK. 

5.2.2 Associating a Goal with an MV Test 

To measure the effectiveness of an MV test using engagement value you must first associate a goal 
with your test. The goal must also have points allocated to it. In this example, choose the Register 
goal and allocate it 5 points. 

To associate a goal with an MV test: 

1. Select one of the content items that you are using in your test. In this example, select the 
Blue-Arrow Register Form control. 

 

2. On the ribbon, in the Analyze tab, Attributes group click Goals. 

3. Select the Register goal. 

4. Click Save. 

To allocate points to a goal: 

1. In the Marketing Center, select a goal. In this example, choose the Register goal. 
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2. In the Points field, enter 5 points. 

 

3. Click Save. 

Now when you run the test every time the register form is submitted, 5 points is added to the overall 
engagement value generated for the test variable used. 

5.2.3 Running an MV Test in the Page Editor 

In the Page Editor, after you click Start Test, it is not possible to make any modifications to the test. 
For example, you cannot add or edit variations or edit the components that you are using in the test. If 
the components in your test contain personalization, this will be paused while the test is running. 

To run a multivariate test in the Page Editor: 

1. In the Page Editor, click the Testing tab and then in the Actions group, click Start Test. 

 

2. In the Start the Test dialog box, enter a name for the test. 
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3. Click Start the Test. 

4. In the Page Editor, you can preview each of your test variables before you run the test. Use 
the arrow to preview each test control. 

 

5. On the Testing tab, in the Components and Combinations section, click the drop-down 
arrow to get an overview of all the components in your test. 

 

6. Run the test in a new browser window. After running the test for the required amount of time, 
click Stop Test. 

7. In the Stop the Test window, you can view all the components in your test and each possible 
combination. You can also see the value that is generated by each variation. Decide which 
component or combination is the most successful and select a winner. 

Note 
You can add more than one component to a multivariate test so that you can decide which 
combination of controls works best on a page. For instructions on setting up multiple 
combinations of controls, see the next section. 

In Engagement Analytics, goals enable site visitors to accumulate value. You can decide 
which variation of the test variables is the most successful by the value it has accumulated 
during the test. The variation with the highest engagement value is the winner. 
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8. In the Stop the Test window, choose a winning test variation variable and click Select. 

 

9. The variation variable that you select stays on the page as your chosen content. The test is 
complete and the Testing group no longer shows any pending tests. 

Note 
If you do not see any results in the Stop the Test window it may be because the test statistics cache 
has not expired. By default the test statistics cache is set to expire after 1 hour. The following setting 
in the web.config file sets the cache expiration: WebEdit.TestStatisticsCacheExpiration. 

The default setting is 01:00:00 (1 hour). To see instant test results ask an administrator to change the 
default setting to 00:00:00. 

5.2.4 Testing Combinations of Content in the Page Editor 

How to test different combinations of components: 

1. Repeat the steps you followed in the previous section to set up the Register Form control. 
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2. Select a different control on the same page of the website. For example, Sidebar Image. 

 

3. In the Test the Component dialog box, add several test variation variables following the 
same steps as described in the previous section. For example, choose several different 
sidebar images to appear in the Sidebar Image control. 

 

4. Save your changes. 

5. In the Page Editor, on the Testing tab, click Start Test to run the test. 
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6. On the Testing tab, in the Components and Combinations group, if you click the drop-
down, you can view all the possible combinations in the test. 

 

7. When the test has run for long enough, click Stop Test. 

8. In the Stop the Test dialog box, there are two tabs that present you with two different ways to 
evaluate the test: 

o By Component 

Or 

o By Combination 

 

By Component – Choose the winning components for each control and then click Select. 
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By Combination – Choose the winning combination of controls and then click Select. 

 

Engagement Value = Value per visit 

Every goal on the website has a numerical value. When a visitor accesses an mv test control 
that has a goal associated with it, the content accumulates a score for the visit, depending on 
how many visitors have accessed this content. 

You can see by studying the engagement values recorded for each component or 
combination of components which content generates the highest value. The differences in 
engagement value recorded in the test results show how you can affect visitor behavior by 
subtle variations in the content on a page. 

5.2.5 Cloning Content Items for MV Tests 

When you use the Page Editor to set up an MV test you can use existing content, clone content or 
create new content items to use as test variable variations. This means that you do not need to ask a 
developer to help you to create special content to use in your MV tests. 

In this section, you test the text in the rotating Flash banner slogan from the header of the Office Core 
website. Test two alternative slogans; ‘Compelling Web solutions’ and Free Web solutions’ to find out 
which is the most effective. 

How to clone Sitecore content for MV Tests using the Page Editor: 

1. In the Page Editor, click the Testing tab. 
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2. On the Home page of the Office Core website, click in the text that appears in the Office Core 
header. 

 

3. In the floating toolbar, click the Test button to open the Test the Component dialog box. 

4. In the Test the Component dialog box, click New Variation to add a new test variation. 

 

5. Add two test variations and give them the following names: 
 

Content Item Variation Name 

Flash-Test-Slogan-1 Free Web Solutions 

Flash-Test-Slogan-2 Compelling Web Solutions 
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6. Select the first variation and browse for a content item. Notice that the Flash object used in 
the Office Core header is already selected. 

 

7. Create a clone from the Flash Object content item.  

Select FlashObject and click Clone Current Content. 

 

8. Make two clones and give them the following names: 

o Flash-Test-Slogan-1 

o Flash-Test-Slogan-2 
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9. Save the clones under the Flash Content folder. 

 

10. You now have three Flash objects in the content tree. 
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11. In the Test the Component dialog box, you have two variations for your test using clones of 
the original Flash object. 

 

12. To save your changes, click OK. 

Now add the text that you want to appear on the website for each of the test variation variables: 

1. Select the text on the home page that you want to edit, so that the floating toolbar appears. 

2. Use the up and down arrows to select each test variation variable you want to edit. 

 

3. Click in the text and edit it in the same way as any other content on the website. Select the 
Free solutions variation and enter the text ‘Free Web Solutions!’ To make the test very clear, 
you could add the same text for all the rotating banners in this Flash control. 
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4. Follow the same steps for the ‘Compelling Web Solutions!’ slogan. 

5. On the Testing tab, click Start the Test. 

 

Enter a name for your test, such as Flash Test Slogans and click OK. 

6. When you have run the test for the required amount of time select a winner in the Stop the 
Test dialog box. 

7. This example demonstrates how easy it is to create your own content for MV tests without the 
help of the IT department. 

8. To test the effectiveness of this MV test you could also assign goals to your test variable 
variations and measure the engagement value that these slogans generate on your website. 
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5.3 Creating a Multivariate Test in the Content Editor 

In the following example, create a multivariate test for a newsletter register form using the Content 
Editor.  

How to create a multivariate test in the Content Editor: 

1. Open the Content Editor and select a content item. For example, Home. 

2. Click the Presentation tab and then click Layout Details. 

3. In the Layout Details dialog box, click Edit. 

4. Click Controls and select a suitable control. For example, Register Form. 

 

5. Click Test, to open the Test the Component dialog box. 

6. Click New Variation, to add each of your test variation variables. 
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7. When you have added all your test variables click OK. 

 

8. Open the Marketing Center. 

9. In the Marketing Center, Test Lab node, select the Home test definition item. 

 

10. In the Test Lab, a test definition item and test variables are added automatically when you 
create test variables in the Test the Component dialog box. 
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11. On the Review tab, Workflow group, click Deploy to run the test. 

 

Note 
This is automatic when you create a test in the Page Editor. 

1. Enter a comment, when prompted in the workflow. 

2. Click End Test to end the test. 

 

Note 
If you create an MV test using the Content Editor you do not have access to the same statistics on 
Engagement Values generated when you test these controls. We recommend that, if possible, you 
create all MV tests using the Page Editor. 
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5.4 Creating a Page Level Test in the Content Editor 

Create a page level test to test a whole page and not just a single component (rendering) on a page. 
This could be an appropriate strategy for testing landing pages or email campaign messages. 

The following example uses Office Core and the Architectural Digest campaign landing page. A 
marketer wants to test 3 different versions of the same landing to find out which is the most effective. 
To create this test you need three alternative landing pages for the Architectural Digest campaign. 

To create a page level test: 

1. In the Sitecore Desktop, open the Marketing Center. 

2. In the Test Lab, create a Page Level Test Definition item. To do this, on the ribbon, select 
the Home tab, Insert group and then click Page Level Test Definition. Keep the default 
name for this item. 

 

3. With the Page Level Test Definition item selected, create a Page Level Test Variable in the 
same way. 

4. With the Page Level Test Variable item selected create 3 new empty Page Level Test 
Values. 

 

To create pages (content items) to use in the test: 

1. Open the Content Editor. 

2. Select the Architectural Digest landing page item in the Standard Items folder. 

3. Insert two new copies of this page below the Architectural Digest landing page item. 
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4. Name the first item “Architectural-Digest 1” and second item “Architectural-Digest 2”. 

 

5. Create aliases for each of the copies of the Architectural Digest page. 

6. Edit some of the campaign text or add an image so that these items look different to the 
original design in some way. 

7. Save your changes. 

Configuring and testing the test: 

1. Open the Content Editor. 

2. Select the Page Level Test Definition item and then use the Test Strategy field to choose a 
test strategy. Choose Random. 

3. Link each of your test variables to the pages you want to test. To do this, select one of your 
test variables that you created and then in the Datasource field, enter the path to the content 
item you want to link it to. Use the Insert link button or enter a path manually. Repeat this 
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procedure for each of your test values. 

 

4. Select the original Architectural-Digest item (the content item you want to test). Link this item 
to the Page Level Test Definition item. To do this, in the ribbon, click the View tab and 
select Standard fields so that you can see the Layout panel in the Content tab. 

5. Scroll down so that you can see the Page Level Test Set field. Click Insert Link to add the 
path to your Page Level Test Definition item. 
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6. Save all your changes. 

7. Move the test variables that you created through the workflow. 

To do this, select your Page Level Test Definition item and in the ribbon, select the Review 
tab and click Deploy. Enter a comment, such as Run test. Your page level test is now 
running. 

 

Note 
To end the test, you must use the End Test command in the workflow. 

8. Finally, publish all your changes. In the Publish Wizard, select Smart publish. 

9. To test your page level test, open a new browser window and enter the name of your website. 

Use the alias you created to navigate to the Architectural Digest page of the Office Core 
website. If the test is working you should see a different version of the page every time you 
click refresh (if you selected the Random test strategy). 
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Note 
You cannot edit any of the components in the test once you have started the test. 

 

Note 
There are no default reports available yet for Page Level Testing. 

5.4.1 Editing a Page Level Test in the Page Editor 

After you have created a page level test in the Content Editor you can also edit the test using the 
Page Editor. To enable this, first you need to change the application options in the Content Editor. 

To enable page level testing in the Page Editor: 

1. Open the Content Editor. 

2. Click the Sitecore button. 

 

3. Then click Application Options. 
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4. In Application Options, click the View tab, select the Show the Test Lab Section check 
box and click OK. 

 

5. Open the Page Editor and navigate to the page that you are testing. In this example, it is the 
Architectural Digest page. 

6. Click the Testing tab to see the test that you are running and to preview each of your test 
values. 
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7. To change the test variables in your page level test, click the Advanced tab and then click 
Details. 

8. In the Layout Details dialog box, select a placeholder such as Columns Content and Right. 

9. In the Control Properties dialog box, scroll down to Test Lab. 

 

In the Tests field you can enter a link to another page level test definition item or change the 
test variables in your current page level test. 

Note 
To create a new page level test you still need to use the Content Editor. The functionality for page 
level testing in the Page Editor is limited. 
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Chapter 6  

Personalization 

This chapter explains how to use the inline personalization functionality in the 
Sitecore Page Editor. This feature allows you to push predefined content at website 
visitors who fulfill specific conditions. 

This chapter contains the following sections: 

 Inline Personalization 

 Creating a Personalization Rule in the Page Editor 

 Creating a Personalization Rule Based on a Pattern Card 

 Personalization in the Content Editor 
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6.1 Inline Personalization 

Personalization allows you to deliver targeted content to specific site visitors. An appropriate time to 
implement this is after segmentation has enabled you to identify the visitors that you most want to 
target. 

You can easily implement rules that show or hide content to site visitors based on their browsing 
behavior and their accumulated profile values. You can make your site respond in real-time by 
showing specific content, hiding content, or adjusting the behavior of a web control. 

The Page Editor contains inline personalization functionality that allows you to specify the rules and 
conditions that must be met before personalized content is displayed. It also lets you test this 
functionality before you publish it on your website. 

6.1.1 Pre-requisites 

Before you can create a personalization rule you need the following components: 

 Content items to use as the data source for the personalization rule. 

 A Web control or rendering item. 
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6.2 Creating a Personalization Rule in the Page Editor 

In the Page Editor, you can create rules to determine which content is shown to different site visitors. 
This is called a conditional rendering or personalization rule.  

In this example, we create a rule that determines when site visitors see the Office Core brochure link. 

The Office Core site, displays a brochure download link on every page, apart from the Home page. 
This rule specifies that the brochure link on the Our Services page is only displayed to visitors who 
have a lead score of 20 or more. 

To implement this personalization rule, you must: 

 Create a conditional rendering rule. 

 Configure the behavior of the webpage. 

You can create personalization rules that are based on many different criteria including goals, 
campaigns, engagement value points, profile value points, and engagement plans. 

Creating a Personalization Rule 

Before you can specify that specific content should be shown to visitors who fulfill certain criteria, you 
must create a personalization rule that contains these criteria. 

To create a personalization rule: 

1. In the Sitecore Desktop, click Sitecore and then click Page Editor. 

2. In the Page Editor, click the View tab and in the Enable group, select the Designing check 
box to enable the design functionality in the Page Editor. 

3. Navigate to the page where you want to implement the personalization rule. In this example, 
you want to edit the Services page. 

4. In the sidebar, select the Want more information section and a floating toolbar appears. 
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5. In the toolbar, click the Personalize Component  button to open the Personalize the 
Component dialog box. 

 

6. In the Personalize the Component dialog box, click New Condition and the dialog box 
displays a new condition. 

 

7. Give the new condition an appropriate name — Only Show Brochure to Leads. 
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8. To define the condition for this component, click Edit and the Rule Set Editor dialog box 
appears. 

 

9. In the Select the condition for the rule field, in the Filter field, enter profile and select the 
following condition: 

“where the value of specific profile key compares to specific value”  

This rule is now displayed in the Rule description field. 

 

Now you must edit the values in this condition so that only visitors who have accumulated a 
lead score of 20 or more can see the brochure download link. 
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10. In the Rule description field, click “specific” to open the Select Profile Key dialog box.  

 

11. In the Select Profile Key dialog box, expand Score and select Lead. 

12. In the Rule Set Editor dialog box, in the Rule description field, click “compares to” to select 
a comparison to use in this rule. 

13. In the Select Comparison dialog box, select “is greater than or equal to” and click OK. 

 

14. In the Rule Set Editor dialog box, in the Rule description field, click “specific value”, to enter 
a numerical value.  

In this example, you want the brochure download link to be displayed on the Our Services 
page when the Lead profile score of the visitor is higher than 50. 
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15. Enter 50 and click OK. 

 

Configuring the Behavior of a Webpage 

After you have defined the conditional rendering rule, you can specify the behavior or action that you 
want the page or component to perform when the conditions in the rule are met. You configure these 
actions in the Personalize the Component dialog box and can show or hiding particular content, as 
well as adjust the behavior of a web control and the way it is presented. 

To configure an action for a webpage component: 

1. In the Page Editor, click the Personalize Component  button to open the Personalize 
the Component dialog box. 
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2. To specify that the website should not show this component to visitors who are not leads, in 
the Default condition, select the Display Component check box. 

 

Now when a visitor comes to the Our Services page, they only see the download the Office Core 
brochure link if they have a lead score of 50 or more. 

In the Page Editor, you can see that the floating toolbar now contains extra information about how 
many conditions have been defined, which one is currently selected, and the component displays the 
content that is specified in the current condition. 

You can see how the personalization rules that you specified affect the content that is displayed in 
this component. 

In the floating toolbar, you can scroll between the different conditions to see how they affect the 
component and the content it displays. 

If the visitor has a lead score of 50 or more, the component displays the content about our brochure: 
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If the visitor has a lead score of less than 50, the component does not display the content about our 
brochure. 

 

How Sitecore Evaluates Personalization Rules 

When a visitor comes to this page, Sitecore evaluates the personalization rules in the order they 
appear in the Personalize the Component dialog box. 

 

In this example, Sitecore evaluates the Only Show Brochure to Leads condition first. If the visitor 
satisfies the rule specified in this condition and has a lead score of 50 or more, Sitecore displays the 
specified content. If the visitor doesn’t satisfy the rule specified in this condition, Sitecore moves on to 
the next condition, and so on, until the visitor meets one of the conditions. 

The default condition is used if the visitor meets none of the other conditions. 

Publish the Personalization Rule 

You must publish this new rule before you can use it on your website. 

To publish the personalization rule: 

1. In the Marketing Center, on the Publish tab, in the Publish group, click Publish, Publish 
Item.  

2. In the publishing wizard, select the Smart Publish option. 
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Testing the Rule 

To test that the rule works: 

1. In a new browser window, open the Office Core website.  

2. Navigate to the Our Services page.  

Notice that there is no longer a brochure displayed in the right-hand column.  

3. Explore the site a little more and return to the Our Services page.  

Once you have accumulated a lead score of 50 or more, the brochure link will appear in the 
right-hand column. 

Personalizing the Content 

When you are setting up a personalization rule, you can also specify that the page should show some 
different content if the rule is satisfied. You can also specify that it should use a different design for 
the content it displays. 

To display different content: 

1. In the Page Editor, open the Personalize the Component dialog box. 
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2. In the Personalize the Component dialog box, select the rule you want to edit and in the 

Personalize Content field, click the Browse  button. 

 

3. In the Select the Associated Content dialog box, the Select Existing Content option is 
selected by default.  

You use this option when you select an existing content item to display instead of the current 
content item. 

You can also use the Search for Content option to search for a content item and then apply 
the appropriate search operation to the item. 

4. Navigate through the content tree and select the content item that you want to display. The 
content item must be compatible with the current rendering. 

This new item is displayed when the rule specified in this condition is met. 
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Personalizing the Layout for a Component 

You can also personalize the way a component is displayed on a webpage. 

To personalize the layout of a component: 

1. In the Page Editor, open the Personalize the Component dialog box. 

 

2. In the Personalize the Component dialog box, select the Enable personalization of 
component design check box and the dialog box displays some more options. 
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3. In the Personalize Component field, click the Browse  button. 

 

4. In the Select a Rendering dialog box, select the rendering that you want to use for this 
content with this personalization rule. 

The rendering must be compatible with the current content item. 
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6.3 Creating a Personalization Rule Based on a Pattern Card 

When you create a personalization rule or conditional rendering, you can base the rule on one or 
more of the pattern cards that you have created. This means that you can create personalization rules 
that target visitors whose interests and behavior match the market segments that you have identified 
and with whom you want to interact in a particular way. 

Note 
The following example is based on the previous personalization example and only describes how to 
set up the personalization rule. 

To base a personalization rule on a pattern card: 

1. In the Sitecore Desktop, click Sitecore and then click Page Editor. 

2. In the Page Editor, click the View tab and in the Enable group, select the Designing check 
box to enable the design functionality in the Page Editor. 

3. Navigate to the page where you want to implement the personalization rule. In this example, 
you want to edit the Services page. 

4. In the sidebar, select the Want more information section and the floating toolbar appears. 

 

5. In the toolbar, click the Personalize Component  button to open the Personalize the 
Component dialog box. 
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6. In the Personalize the Component dialog box, click New Condition and the dialog box 
displays a new condition. 

 

7. Give the new condition an appropriate name — Only Show Brochure to Decision Makers. 

8. To define the condition for this component, click Edit and the Rule Set Editor dialog box 
appears. 

 

9. In the Select the condition for the rule field, in the Filter field, enter pattern and then select 
the following condition: 

where the current visit matches the specific pattern card in the specific profile 
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This rule is now displayed in the Rule description field. 

 

Now you must edit the values in this condition so that only visitors who are mapped to a 
particular pattern card can see the brochure download link. 

10. In the Rule description field, click specific profile to open the Select Profile dialog box. 

 

11. In the Select Profile dialog box, select Focus. 
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12. In the Rule Set Editor dialog box, in the Rule description field, click specific pattern card to 
open the Select Pattern dialog box. 

 

In the Select Pattern dialog box, you can see all the pattern cards that have been created for 
the Focus profile 

13. Select the Decision Maker pattern card and click OK. 

You have now created a personalization rule or conditional rendering that uses a pattern card and 
only applies to visitors whose behavior on your website is mapped to this pattern card. 

To complete the implementation of this personalization example, see the section Creating a 
Personalization Rule in the Page Editor. 
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6.4 Personalization in the Content Editor 

You can also assign and edit personalization rules in the Content Editor. However, we don’t consider 
this method to be suitable for marketers because the user interface is more developer oriented. 

You can either search for content items or use the content tree 

To view the personalization rules assigned to a content item in the Content Editor: 

1. In the Content Editor, select the content item that you assigned some personalization rules 
to in the previous section — Services. 

2. Click the Presentation tab and then in the Layout section, click Details. 

 

In the Layout Details dialog box, you can see all of the layouts, controls, and placeholders 
that this item uses for the different devices. 

3. In the Browser Fixed section, you can see that the Brochure Links control displays a number 
2. This indicates that you have defined two personalization rules on this control for this 
device. 
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4. In the Browser Fixed section, click Edit and the Device Editor dialog box appears. 

 

5. In the Device Editor dialog box, click Controls and a list of controls is displayed along with a 
list of buttons. 

6. Select the Brochure Links control and then click Personalize and the Personalize the 
Component dialog box appears. 
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7. Click Personalize Content to open the Select the Associated Content dialog box. 

 

8. In the Select the Associated Content dialog box, click Search for Content and enter 
Brochures in the Search field. 
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Note 
The Search for Content option is especially useful if your site contains thousands or millions 
of items that may be hard to find in the content tree. 

9. Select the Brochures item and click OK to add it to the ‘Only Show Brochure to Leads’ 
personalization rule.  

Next you need to set up a rule that specifies only visitors who score 50 or more in the Lead 
profile key value will see a brochure. 

Adding or changing a personalization rule condition: 

1. In the Personalize the Component window, add a personalization rule. Click Edit to open 
the Rule Set Editor. 

2. In the Rule Set Editor dialog box, enter the word ‘profile’ to see all rules related to profiles 
and profile values. 

3. .In the rules that appear under Profiles and Patterns, select the rule where the value of 
specific profile key compares to specific value. 

 

4. In Rule description, edit the rule. First click the word specific to select a profile key. 
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5. In the Select a Profile Key window, use the Search tab to find the profile key you want to 
use in this rule. 

 

6. Enter the word ‘Lead’ in the search box. 

 

7. Select the Lead profile key and click OK. 

8. To select a numerical comparison, click compares to, select ‘greater than or equal to’ and 
click OK. 

9. In specific value, enter 50. 
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When you have finished configuring your rule, the Personalize the Component dialog box 
should look something like this: 

 

Now when visitors come to the site, only visitors that are classified as leads (by matching this 
condition) see a brochure. 
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Chapter 7  

Viewing Reports, Dashboards and Analyses 

In Sitecore you can analyze the marketing effectiveness of your website in several 
different ways. You can use the Executive Insight Dashboard to get an overview of 
marketing channels and campaigns. View Engagement Analytics reports to see the 
visitor session information, identify sales leads and monitor site health. Business 
intelligence consultants and marketing analysts can also use Engagement 
Intelligence analyses to drill down into DMS data to get an even more detailed insight. 

This chapter mainly focuses on the standard reports available in Engagement 
Analytics. 

This chapter includes: 

 Viewing Engagement Analytics Reports 

 Classifying Site Visitors 

 Subscribing to Reports 

 Linking to CRM 

 Saving and Filtering Reports 

 Executive Insight Dashboard 

 Engagement Intelligence 



Marketing Operations Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2013 Sitecore. All rights reserved.  

Page 99 of 123 

7.1 Viewing Engagement Analytics Reports 

Engagement Analytics contains a number of standard reports that you can run out of the box. Reports 
are available in the following categories: 

 

 

Sales 

Lead reports by Activity or Value 

 

Site Health 

Slow pages, URLs not found 

 

Recent Activity 

Latest Visits 

 

Engagement Analytics item reports are also available when you select a content item in the Content 
Editor. 

 

For more information, see section 7.1.4 Item Reports. 

To open an Engagement Analytics report: 

1. In the Sitecore Desktop, click the Sitecore button and then click Engagement Analytics. 

2. In Engagement Analytics, click the node you want to expand, such as Sales, and then click 
on a report such as Top Leads by Activity, Classified Organizations. 
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The report opens in the right-hand panel of the Engagement Analytics window.  

 

7.1.1 Sales 

You can configure the sales area to display your own reports. For example, if you decide to record 
lead scores, you can display lead reports for your sales team. 

You can identify your competitors here. You can create analyst and press reports in a similar way to 
competitor reports. 

Your site administrator can help you to configure reports for this area. 
 

Sales Reports Description 

Top Leads by Activity – Classified Organizations Used by sales teams to identify which 
classified organizations have shown 
the highest levels of activity on the 
website. 

Top Leads by Activity – Unclassified Organizations Used by sales teams to identify which 
unclassified organizations have shown 
the highest levels of activity on the 
website. 

Top Leads by Value - Classified Organizations - Daily Used by sales teams to identify which 
classified organizations have 
accumulated the highest value visits 
on a single day. 

Top Leads by Value - Classified Organizations - Periodic Used by sales teams to identify which 
classified organizations have 
accumulated the highest value visits 
over a specific period. 

Top Leads by Value - Unclassified Organizations – Daily Used by sales teams to identify which 
unclassified organizations have 
accumulated the highest value visits 
on a single day. 
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Sales Reports Description 

Top Leads by Value - Unclassified Organizations - Periodic Used by sales teams to identify which 
unclassified organizations have 
accumulated the highest value visits 
over a specific period. 

 

Default sales report parameters: 
 

Sales Report Parameters Description 

Activity Level 
 

Used by sales teams as a way of comparing website activity levels 
between different visiting Business Units. 
Sales teams can use this information to identify potential leads. 
 
The formula used to calculate activity level is: 
INTEGER(10*Visits * Unique Visitors/Days) 

 
This formula generates a whole number that makes it easier to 
compare activity levels regardless of how many unique visitors there 
were or how many visits came to your site. 

Value 
 

The accumulated sum of engagement value points generated during 
one or more visits. 

Visitors 
 

The number of unique visitors to the site. 

Visits 
 

The total number of visits to the site. 

Recency 
 

The date of the most recent visit. 

To see a more detailed description of the business purpose of a report click Report Description. This 
information is available on all standard reports. 

 

7.1.2 Site Health 

In Engagement Analytics, Site Health contains reports on any failures that occur on your website. Site 
Health Reports can help you identify potential problems with your website or on your web servers. 
This is useful information that could highlight potential problem areas that require further investigation.  

Expand the Site Health node to view all the available reports. 
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For example the Slow Pages report: 

 
Site Health Reports Description 

Common Mistakes List the most common mistakes that occur on the web site, 
such as, no search hits found, user subscription failed, login 
failed, and so on. 

Latest Failures Lists all the latest failures on the web site, for example, if a 
visitor had difficulty logging in or if a visitor performed a local 
search that gave 0 results.  

Not Found URLs Lists all the not found URLs.  
If a URL appears as Direct, it means that the visitor typed the 
address incorrectly into the browser. These are the most 
common not found URLs. 

Pages that Report Errors Lists all the pages that report errors. 

Slow Pages Lists all the pages that loaded slowly with the slowest listed 
first. 
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7.1.3 Recent Activity 

Recent activity reports record the latest visits to your website. View the Latest Visits report, to see a 
list of all the visits to your website, in chronological order, listed by organization: 
 

 

 

Under Latest Visits you can drill-down to the following sub reports: 

 Business Overview 

 Visitor Overview 

 Business Visits 

 Visit Detail 
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Click on the name of an organization in the Latest Visits report to view the Business Overview report: 

 

The Business Overview report shows more detail on the business unit you selected. It displays a map 
of the business location and statistics such as total value accumulated during all visits and the 
number of visits for the organization. 
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In the Business Overview report, click on one of the listed visitors under Top 20 Visitors to view the 
Visitor Overview report. 

 

The Visitor Overview report shows the engagement value accumulated during visits and the number 
of visits. It displays goals, provides information that can help you to calculate activity levels and gives 
you an indication of what the visitor is interested in on your website. 

In the Business Overview report, click on the number of visits displayed under Total Visits to view the 
Business Visits report: 

 

The Business Visits report displays a chronological list of all visits made by the organization. Click on 
a single visit timestamp, to display the Visit detail (Session) report. 
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The Visit Detail (Session) report displays all the details of a single visit. Click on the report description 
to get a more detailed description of the business purpose of this report.

 

Summary of information contained in the Visit Detail (Session) report: 
 

Visit Details Description 

Visitor Visitor company or organization. 

Location Visitor country and city of origin (based on IP address). 

Business Name  Business name of website address. 

Company Company name. 

Referred From Web site where search originated, for example Google.com. 

Search Term Search engine, search term used to find the website.  

ISP Name of Internet Service Provider. 

Visit Value Total value accumulated during this visit.  

Visit # of Total The number of the visit in relation to the total number of visits. 
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Visit Details Description 

Visit Pages The number of pages viewed on the site during this visit. 

Visit Duration Amount of time the visitor spent on this page. 

Profile values Charts displaying profile scores for each profile key accumulated 
during this visit. 

Date/time Date stamp of visit. 

# Sequential number of visit. 

Duration The amount of time spent on this specific page during the visit. 

Page All the web pages viewed during this site visit and hyperlinks that link 
back to the actual web pages. Each URL on the list has a timing 
associated with it. 

7.1.4 Item Reports 

Item reports provide engagement analytics information on the performance of individual pages on 
your website. For example, you can see the goals and page events triggered by visitors to a particular 
page. 

To view an item report: 

1. In the Sitecore Desktop, open the Content Editor. 

2. In the Content Editor, content tree, select an item. 

3. In the Sitecore ribbon, select the Analyze tab and then click Reports. 

4. A new Reports tab appears next to the Content tab, right of the content tree. 
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The following table lists the default item reports that are available from the Sitecore Content Editor: 
 

Report Description 

Local Searches Leading to 
this Page 

This report lists the search terms that visitors use on your website 
and which lead them to this page. These are the words and phrases 
that visitors are interested in but are unable to find through using the 
menu, links, or other typical browsing activities. 
 

Local Searches on this Page This report lists the words and phrases that visitors searched for 
while they were on this page. 
 

Page - Goals and Events This report shows how this page contributes to goal conversion and 
value consumption. 
 

Top External Keywords 
Leading to this Page 

This report shows the top external keywords visitors used in this 
time period to come to this page. Keywords are ranked by the value 
accumulated by visitors who used this keyword. 
 

Top Traffic Sources Coming to 
this Page 

This report lists the top external traffic sources for this page during 
the selected time period. 
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7.2 Classifying Site Visitors 

Engagement Analytics lets you classify the visitors that come to your website. You can classify visitors 
as coming from your own company, as competitors, as robots, and so on. You can use these 
classifications to filter your statistics thereby improving their quality, and ultimately improving your 
visitor segmentation. 

We recommend that you classify site visitors early and often to make your site statistics more 
meaningful. Classifying visitors benefits your organization, helps enable your sales force, and makes 
the task of personalizing content easier. 

To classify a site visitor: 

1. Open Engagement Analytics. 

2. Expand Recent Activity and then click the Latest Visits report. 

3. Select a visitor session that is unclassified. 

4. Click Classify to open the Visitor Classification dialog box. 

 

5. In the Visitor Classification dialog box, use the sliders to select appropriate values. 

In the Office Core website we have defined the following values: 
 

Attribute Description of values 

Business, IP Address, DNS, 
This Visitor 

Select one of the following values: 

 Unidentified 

 Business 

 ISP 

 Existing Customer 

 Analyst 

 Press 

 Supplier 

 Business Partner 

 Competitor 

 My Company 
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Attribute Description of values 

 Bot – Feed Reader 

 Bot – Search Engine 

 Bot – Unidentified 

 Bot – Auto-detected 

 Bot - Malicious 

User Agent Select one of the following values: 

 Bot – Feed Reader 

 Bot – Search Engine 

 Bot – Unidentified 

 Bot – Auto-detected 

 Bot - Malicious 

6. Click OK to save your changes. 

Note 
The attributes and values in this section that illustrate the concept of classification come from the 
Office Core website. 
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7.3 Subscribing to Reports 

You can subscribe to reports that are of special interest to you. For example, if you subscribe to a 
report for a specific site visitor, Sitecore sends you a report every time this visitor returns to your 
website. 

To subscribe to a report: 

1. Open Engagement Analytics. 

2. Open the report that you want to subscribe to. 

3. Click Subscribe. 

 

Sitecore already has your e-mail address as part of your Sitecore user information. When you 
have subscribed to a report, Sitecore displays the following message: 
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7.4 Linking to CRM 

You can also link Sitecore reports with your CRM system. 

If you click on CRM, Engagement Analytics displays the following message: 

CRM Integration Page - not yet implemented 

 

However, the way in which this link works depends on how you have implemented CRM integration 
on your website. 

For more information about CRM integration, contact your website administrator. 
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7.5 Saving and Filtering Reports 

There are various ways in which you can improve the relevance of Sitecore reports. 

You can: 

 Change the date range used in a report. 

 Save a report. 

 Place filters on a report. 

 Print a report. 

7.5.1 Selecting a Date Range 

When you open a report, you can see the date range for the data in the report at the top of the 
Engagement Analytics report viewer. 

 

To change the date range of a report: 

1. Open a report in Engagement Analytics. 

2. Click the date at the top of the report and you see a date range filter. 

 

3. In the Date Range fields, enter a start and end date directly into the date fields or alternatively 
click the calendar icons to select specific dates. 

4. Click Apply to update the report and to save your date selection. 
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In Sales, Daily Reports, there is no data range filter only the option to select a single date. 

 

7.5.2 Saving a Report 

In Engagement Analytics, you can save a report in a number of different formats, such as, Word, 
PDF, XML, Excel, Text file format, and so on. Saving a report in this way is quick and easy. 

To save a report:  

1. Open Engagement Analytics. 

2. Open a report, such as Slow Pages. 

3. Click Save to see the options that are available. 
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4. Select a file format, for example Microsoft Word 2007. 

 

5. Open or save the report.  

6. If you decide to save the report, you can store the report in a local folder. 

7. Follow the same procedure to save the report in any of the other file formats. 

7.5.3 Printing a Report 

When you view a report in Sitecore Engagement Analytics, you can print it directly from the report 
viewer. 

To print a report: 

1. In Engagement Analytics, open a report, such as Slow Pages. 

2. Click Print. 

3. Select one of the three available print options. 

 
Print Option Description 

Print to PDF Preview the report as a PDF document in Adobe Reader or 
save it as a PDF file. 

Print with Preview Previews the report in Internet Explorer print format. In 
Internet Explorer, click File, Print to print the report. 

Print without Preview Displays the Print dialog box 

4. In the Print dialog box, click Print. 
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7.5.4 Filtering a Report 

In Engagement Analytics, you can filter any report to change the data that it contains. 

To filter a report: 

1. In Engagement Analytics, choose a report to filter, such as Latest Visits. 

2. In the Latest Visits report, click Filter to open the Filters Editor dialog box. 

 

3. In the Filter Editor dialog box, select one or more a filters. 

 

4. In this example, select the following values: 
 

Filter Value 

Visitors Analyst 

Culture UK 
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5. Click OK and you can now see the Latest Visits report filtered to show all visits by analysts 
from the UK for the specified time period. 

6. To make a separate report for this filtered version, create a duplicate report definition item 
and a duplicate .mrt file. 

Note 
Administrators can create new filter criteria to expand the selection available in the Filter Editor. 

7.5.5 Filtering a Report to Segment Site Visitors 

In Engagement Analytics, you can create filters to segment site visitors according to geography, 
profile or any other criteria. For example, you might want to create a new filter value for a specific 
county segment, such as Brazil. 

Creating a New Filter Value 

To create a new filter value for Brazil: 

1. Open the Marketing Center and in the content tree, navigate to: 

/sitecore/system/Marketing Center/Analytics Filters/Report Filters/Culture 

2. In the Insert group, click Predefined Filter Value. 

 

3. Name the new filter item Brazil. 
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4. In the Value field, enter BR, which is the country code for Brazil. 

 

5. Save your changes. 

6. In Engagement Analytics, open the Recent Visits report. 

7. In the Recent Visits report, select a suitable date range and then click Filter. 

8. In the Filter Editor dialog box, you can now select the Brazil filter. 
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9. Click OK and in the Recent Visits report you now only see visits from Brazil. 

 

Assigning an Icon to the Filter 

To assign an icon to your filter: 

1. Open the filter item. 

2. Click the filter icon in the content item to open the Icon dialog box. 

 

3. In the Icon dialog box, open the drop down box and select Flags. 

4. Select the icon for the Brazilian flag and click OK. 

For more information about creating reports, see the Report Designer Cookbook. 
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7.6 Executive Insight Dashboard 

The Sitecore Executive Insight Dashboard provides marketers and SEO analysts a high level 
overview of the performance of their website, with a particular emphasis on individual marketing 
channels and campaigns. 

It presents data from the DMS in charts that enable you to see at a glance which of your marketing 
activities are most successful and which need attention so that you can optimize your SEO strategies 
in the future and in turn increase ROI. 

7.6.1 Viewing Charts and Dashboards 

To view a dashboard, in the Sitecore Desktop, click the Start button and then click Executive Insight 
Dashboard. 

 

For more detailed information about using the Executive Insight Dashboard including some examples 
of business scenarios, see the Executive Insight Cookbook on SDN. 
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7.7 Engagement Intelligence Analyzer (EIA) 

Sitecore Engagement Intelligence provides multiple analyses that enable business intelligence 
consultants and marketing analysts to effectively analyze the data in the Sitecore Digital Marketing 
System (DMS). 

7.7.1 Viewing Analyses and Objects 

In the Engagement Intelligence Analyzer, you can drill down into analyses and objects to analyze in 
detail site visits, value generated, campaigns visited, goals converted and other data collected on 
your website and stored in the Analytics database. 

You can use dimensions and measures in the OLAP cube to combine categories of data to spot 
trends and to effectively assess and optimize your marketing activities 

The EIA comes with several predefined analyses, and you can use its drag-and-drop interface to 
quickly and easily create new ones. For example, follow the steps in the Intelligent Analysis Wizard to 
create custom columnar style analyzers. 

To view an Engagement Intelligence analysis using TARGIT NET: 

1. In the Sitecore Desktop, click the Sitecore start button. 

2. To open the Engagement Intelligence Analyzer, click Engagement Intelligence. 
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3. In the Engagement Intelligence Analyzer, use the navigation bar to select the Analysis you 
want to view. 

 

4. Each Analysis consists of one or more objects. Select an object and drill down into the data. 
For example, you could first open the Campaigns Analysis and then select a specific 
campaign to analyze it in detail. 

Note 
This example analysis uses the TARGIT NET business intelligence UI. If you do not wish to 
use TARGIT for your front end, you could create your own custom UI for Engagement 
Intelligence. 

7.7.2 EIA Components 

The main component parts of Engagement Intelligence are an OLAP cube (high speed database) and 
front end business intelligence UI. In Sitecore, the Engagement Intelligence Analyzer (EIA) has a 
Windows client and a web UI (provided by TARGIT). 

Engagement Intelligence key components: 

 Engagement Intelligence Analyzer (EIA)  

 Datamart (SQL views and OLAP database) 

 Business Intelligence UI (TARGIT or another solution) 

 DMS Data Optimization Tool 

Datamart 

The Datamart is the back end for Engagement Intelligence and consists of two main components: 

 Microsoft SQL Server Views. 

 OLAP cube – deployed on a Microsoft SQL Server Analysis Services. 

The Datamart processes data from the analytics database for use with the TARGIT Analyzer. 
Depending on your system architecture you can create additional SQL Server Views in either the 
reporting or analytics databases. 
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TARGIT BI Suite (ANT Server) 

TARGIT Management Studio that gives you access to the Windows client and all the tools you need 
to manage the TARGIT dashboard application. 

TARGIT NET 

The Engagement Intelligence Analyzer is the Targit application for viewing analyses and objects 
based on the Analytics data contained in the OLAP cube. 

Other Reporting Tools 

If you choose not to use TARGIT to analyze your analytics database then you will need to create your 
own analyses. Engagement Intelligence is flexible enough to allow you to develop your own front end 
solution. 

For more detailed information on Engagement Intelligence, see the Engagement Intelligence 
documentation on SDN. 

Useful documents include: 

 Engagement Intelligence Datamart Installation Guide 

 Engagement Intelligence Analyzer Installation Guide 

 EI Dimensions and Measures Reference 


	Chapter 1  Introduction
	1.1 The Sitecore Customer Engagement Platform
	Security Roles and Sitecore Engagement Analytics


	Chapter 2  Content Profiles
	2.1 Content Profiling
	2.1.1 Profile Values, Web Pages, and Content Items
	2.1.2 Pre-requisites

	2.2 Profiles, Profile Keys, and Profile Cards
	2.2.1 Creating a Profile Card
	Assigning Profile Values to a Profile Card


	2.3 Assigning a Profile Card to a Content Item in the Page Editor
	2.3.1 Assigning Custom Profile Values to a Content Item in the Page Editor

	2.4 Assigning a Profile Card to a Content Item in the Content Editor
	2.4.1 Assigning Custom Profile Values to Multiple Content Items


	Chapter 3  Goals, Campaigns, and Events
	3.1 Goals
	3.1.1 Creating a Goal
	Engagement Value Points

	3.1.2 Deploying and Publishing a Goal
	3.1.3 Associating a Goal with a Content Item
	3.1.4 Associating a Goal with Media Item
	3.1.5 Associating a Campaign or Event with Multiple Content Items

	3.2 Campaigns
	3.2.1 Creating a Campaign
	Deploy the Campaign

	3.2.2 Associating a Campaign with a Content Item
	Online Campaigns
	Publishing the Goals and Campaigns

	3.2.3 Viewing Campaigns in Engagement Analytics
	3.2.4 Viewing Campaign Categories in the Executive Dashboard
	3.2.5 Viewing the Executive Insight Dashboard from the Marketing Center

	3.3 Events
	3.3.1 Associating an Event with a Content Item
	3.3.2 Assigning Failure Actions to Items
	3.3.3 Engagement Value Points and Events

	3.4 Analytics Page Settings

	Chapter 4  Patterns and Pattern Cards
	4.1 Understanding Pattern Cards
	4.1.1 Configuring Pattern Matching

	4.2 Creating a Pattern Card
	Planning your Pattern Card Strategy


	Chapter 5  Testing
	5.1 Multivariate Testing
	5.1.1 Page Editor Testing Options

	5.2 Creating a Multivariate Test in the Page Editor
	5.2.1 Creating an MV Test in the Page Editor
	5.2.2 Associating a Goal with an MV Test
	5.2.3 Running an MV Test in the Page Editor
	5.2.4 Testing Combinations of Content in the Page Editor
	5.2.5 Cloning Content Items for MV Tests

	5.3 Creating a Multivariate Test in the Content Editor
	5.4 Creating a Page Level Test in the Content Editor
	5.4.1 Editing a Page Level Test in the Page Editor


	Chapter 6  Personalization
	6.1 Inline Personalization
	6.1.1 Pre-requisites

	6.2 Creating a Personalization Rule in the Page Editor
	Creating a Personalization Rule
	Configuring the Behavior of a Webpage
	How Sitecore Evaluates Personalization Rules
	Publish the Personalization Rule
	Testing the Rule
	Personalizing the Content
	Personalizing the Layout for a Component

	6.3 Creating a Personalization Rule Based on a Pattern Card
	6.4 Personalization in the Content Editor

	Chapter 7  Viewing Reports, Dashboards and Analyses
	7.1 Viewing Engagement Analytics Reports
	7.1.1 Sales
	7.1.2 Site Health
	7.1.3 Recent Activity
	7.1.4 Item Reports

	7.2 Classifying Site Visitors
	7.3 Subscribing to Reports
	7.4 Linking to CRM
	7.5 Saving and Filtering Reports
	7.5.1 Selecting a Date Range
	7.5.2 Saving a Report
	7.5.3 Printing a Report
	7.5.4 Filtering a Report
	7.5.5 Filtering a Report to Segment Site Visitors
	Creating a New Filter Value
	Assigning an Icon to the Filter


	7.6 Executive Insight Dashboard
	7.6.1 Viewing Charts and Dashboards

	7.7 Engagement Intelligence Analyzer (EIA)
	7.7.1 Viewing Analyses and Objects
	7.7.2 EIA Components



